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Chapter 1:  Introduction 
Overall Learning Objectives 
These are the overall learning objectives for this CDA Validation Plus User Guide: 

• Learn about the various features of the CDA Validation Plus program 

• Learn how to launch and exit CDA Validation Plus  

• Learn about the CDA Validation Plus File, Utilities, and Help menu items  

• Learn how to validate a single CDA document, multiple CDA documents, or run the 
application in batch mode to validate all CDA documents in a user-specified folder  

• Learn how to run the application from the DOS command line  

• Become familiar with the validation and reporting features of CDA Validation Plus, 
including the validation rules applied to the CDA document, as well as the types of 
validation errors that may be generated  

• Learn about the various application sub-folders, their default locations, and content, 
as well as setting a custom database location in the application configuration file 

• Learn about the CDA Validation Plus Access database structure and content 

• Learn how to keep the software up-to-date with the most recently released version of 
the application. 

Overview of the CDA Validation Plus User Guide 
The CDA Validation Plus User Guide provides you with the information to understand and 
use the features of CDA Validation Plus, and describes the functions available to the end 
user.  The major sections include downloading and installing the program, launching CDA 
Validation Plus, learning about and becoming familiar with the various menu items, CDA 
document validation processes, and reporting features of the program. You will also learn 
about the CDA Validation Plus Access database structure and content.  

CDA Validation Plus Background 
The Clinical Document Architecture (CDA) is a markup standard developed by the 
organization Health Level 7 International (HL7) to define the structure of clinical documents 
such as discharge summaries and progress notes. CDA is based on XML, the Extensible 
Markup Language. CDA uses HL7’s Reference Information Model, the goal of which is to 
put data in a clinical or administrative context, to define how pieces of data are associated, 
and to take advantage of coding systems such as Systematized Nomenclature of Medicine -- 
Clinical Terms (SNOMED CT) and Logical Observation Identifiers Names and Codes 
(LOINC). CDA enables the creation of patient records that can be read by any electronic 
medical record (EMR) or electronic health record (EHR) software system. CDA is a flexible 
standard and is unique in that it can be read by the human eye or computer processed.  
The Centers for Disease Control and Prevention (CDC), National Program of Cancer 
Registries (NPCR) Registry Plus suite of software includes an application called Electronic 
Mapping, Reporting, and Coding (eMaRC) Plus. eMaRC Plus has been in use in the cancer 
registration community for years to process pathology reports received in the HL7 Version 
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2.x file format, identifying reportable cancer records and mapping from the HL7 message 
format and codes to the North American Association of Central Cancer Registries 
(NAACCR) Volume II Data Dictionary record layout and codes. 
Functionality has been added to eMaRC Plus to process physician reports generated by EMR 
and EHR vendors and received by the cancer registry in CDA document format and map 
from the CDA data elements and codes to the NAACCR record layout and codes. eMaRC 
Plus assumes that the CDA documents presented to it have already been validated for content 
and structure. In addition, EMR and EHR vendors are in need of a tool with which to validate 
the CDA documents output from their software. As a result, CDC has developed CDA 
Validation Plus for these purposes. 

CDA Validation Plus Features 
CDA Validation Plus is a part of the Registry Plus software suite of publicly available free 
software programs for collecting and processing cancer registry data developed at CDC’s 
Division of Cancer Prevention and Control in support of CDC’s NPCR. CDA Validation Plus 
is a tool used to validate the structure, content, codes, and coding systems of CDA documents 
(based on XML) that are generated by EMR or EHR software systems and submitted to 
central cancer registries for the purposes of cancer reporting. The application is used by 
EMR/EHR vendors to validate cancer CDA documents generated by their products and by 
central cancer registries to validate cancer CDA documents during the on-boarding process 
for providers and prior to subsequent processing in eMaRC Plus.  
CDA Validation Plus performs validations for both MU Stage 2 and MU Stage 3 formats, 
based on the specifications in their respective Implementation Guides: 

1. Implementation Guide for Ambulatory Healthcare Provider Reporting to Central 
Cancer Registries, August 2012, Release 1.0 (“Cancer IG”), which is the standard 
identified for MU Stage 2 cancer reporting objective.  

2. HL7 CDA ® Release 2 Implementation Guide: Reporting to Public Health Cancer 
Registries from Ambulatory Healthcare Providers, Release 1, DSTU Release 1.1 – 
US Realm, which is the standard identified for MU Stage 3 cancer reporting 
objective. 

 

 

CDA Validation Plus does not REPLACE the testing and validation 
process that MUST be completed by EHR vendors with the Office of the 
National Coordinator - Authorized Testing and EHR Certification Bodies 
(ONC-ATCBs) to receive the required MU certifications. Rather it is used 
to augment the validation process for improved interoperability in 
cancer reporting.  

 
The MU PH Reporting Requirements Task Force has provided guidance to public health 
agencies for on-boarding new providers, including recommendations for communicating 
results back to senders. Several useful documents, including: “MU2 PHA Readiness 
Guidance Recommendations Handbook”, “Public Health Agency Readiness for Meaningful 
USE, 2015-2018”, and “Functionality Recommendations for Registration of Intent and On-
Boarding Process” can be found at: https://www.cdc.gov/ehrmeaningfuluse/meaningful-use-
mu-public-health-ph-reporting-requirements-task-force.html.  

https://www.cdc.gov/phin/resources/guides/documents/implementation_guide_for_ambulatory_healthcare_provider_reporting_to_central_cancer_registries_august_2012.pdf
https://www.cdc.gov/phin/resources/guides/documents/implementation_guide_for_ambulatory_healthcare_provider_reporting_to_central_cancer_registries_august_2012.pdf
http://www.hl7.org/implement/standards/product_brief.cfm?product_id=398
http://www.hl7.org/implement/standards/product_brief.cfm?product_id=398
http://www.hl7.org/implement/standards/product_brief.cfm?product_id=398
https://www.cdc.gov/ehrmeaningfuluse/meaningful-use-mu-public-health-ph-reporting-requirements-task-force.html
https://www.cdc.gov/ehrmeaningfuluse/meaningful-use-mu-public-health-ph-reporting-requirements-task-force.html


Introduction   CDA Validation Plus User Guide 
 

Version 4.0 May 2018  6 
 

 

On-boarding includes initial contact between the provider and the state registry, testing of 
data exchange, transport testing, content validation, and initiation of routine reporting. It is 
imperative that central cancer registries use CDA Validation Plus to validate the 
content and structure of CDA cancer documents submitted to cancer registries from 
different EHR systems and providers during the on-boarding process and prior to 
subsequent processing in eMaRC Plus.  
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System Requirements  
CDA Validation Plus is programmed for the Microsoft Windows 32-bit environment 
installed on an Intel Pentium or Pentium-compatible computer. The minimum hardware 
requirements are the same as those of the Microsoft Windows operating system used. 
Additional system requirements include: 

• Microsoft operating system from Windows 98 through Windows 8.0  

• 128 MB RAM (512 MB minimum recommended)  

• Latest version of Microsoft Internet Explorer (recommended)  

• The available hard-disk space requirement for CDA Validation Plus depends on 
the number of CDA document validations that will be created and maintained in 
the database. A minimum of 70 MB of free hard drive space is required. 

Launching CDA Validation Plus  
Once installed, you can launch CDA Validation Plus: 
1. This can be done in 2 ways: 

a. From the Start menu, select All Programs, Registry Plus, CDA Validation Plus, 
and then CDA Validation Plus. 

b. Double-click the CDA Validation Tool shortcut icon on your desktop (this is 
placed on your desktop when you install the program). 

 
Result:  The CDA Validation Plus Main window will open. 
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Exiting CDA Validation Plus 
To exit CDA Validation Plus, complete these steps: 
1. Exit CDA Validation Plus.  This can be done in 4 ways: 

a. Click on the File menu, and select Exit. 

 
b. Use the keystroke Alt+F4.  
c. Click the Exit icon             on the tool bar. 
d. Click the X in upper right corner of screen. 

  
Result:  The CDA Validation Plus application closes. 

User Support 
For technical support via e-mail, or to provide feedback on the program, contact the 
Helpdesk at cancerinformatics@cdc.gov. The CDC Registry Plus Development group is 
funded primarily to support NPCR-funded state central cancer registries. CDA Validation 
Plus is intended for distribution to EMR and EHR vendors and central cancer registries. CDC 
will provide support to all end users, and welcomes all feedback regarding the program.   
CDC also provides periodic software updates and problem-solving to the extent of available 
resources. CDC does not provide on-site services. 
 

mailto:cancerinformatics@cdc.gov.
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Chapter 2: CDA Validation Plus General User Basics 
Learning Objectives 
In this chapter, you will: 

• Learn about the CDA Validation Plus File, Utilities, and Help menu items  

• Learn how to validate a single CDA document, multiple CDA documents, or run the 
application in batch mode to validate all CDA documents in a user-specified folder  

• Learn how to run the application from the DOS command line  

• Become familiar with the validation and reporting features of CDA Validation Plus, 
including the validation rules applied to the CDA document, as well as the types of 
validation errors that may be generated  

Overview 
This chapter covers the all of the features available to end users of CDA Validation Plus.  
This chapter describes the various menu items and sub-options as well as the CDA document 
validation processes and the reporting features of the program. 

The CDA Validation Plus Main Window 
The CDA Validation Plus main window provides access to all of the application’s features 
which are located under the File, Utilities, and Help menu items, and can also be accessed 
using the application’s tool bar icons. 
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Keyboard and Mouse Alternatives 
Keyboard and mouse alternatives are available for every function in the software. Note that 
Keystroke options are displayed on menus for all menu items, and Appendix A of this user 
guide contains a listing of standard CDA Validation Plus keyboard shortcuts to functions. 

The File Menu 
The File menu is used to access the main function of CDA Validation Plus, which is to 
validate the CDA document or documents provided by the user. To access the File menu 
items, click on the File menu item, and select the desired sub-option, or use the appropriate 
keystroke combination for the desired sub-option.  

 
The following table describes the CDA Validation Plus File menu sub-options: 

Sub-option (Keystroke) Toolbar Icon Function 

Validate CDA Document 
(Ctrl+M) 

 Validate a cancer CDA 
document or documents that 
you load into to the application  

Exit (Alt+F4) 
 
 
 

Close the CDA Validation Plus 
application 

The Utilities Menu 
The Utilities menu is used to access any supplementary functions included in the program. 
Currently the only utility provided is the ability to look-up code definitions for the codes 
based on various coding systems that are included in CDA documents.  
To access the Utilities menu items, click on the Utilities menu item, and select the desired 
sub-option, or use the appropriate keystroke combination for the desired sub-option.  

 
The following table describes the CDA Validation Plus Utilities menu sub-options: 

Sub-option (Keystroke)  Toolbar Icon Function 

Look-up Code Definitions 
(Alt+L) 

 Look-up code definitions for 
codes based on the various 
coding systems that are 
included in CDA documents 

 
PLEASE NOTE: Due to development priorities, CDA Validation Plus is being released 
without the Look-up Code Definitions feature; description of the Look-up Code 
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Definitions feature provided in this guide is for informational purposes only. This 
functionality will be released in a future version of the program. 

The Help Menu 
The Help menu is used to access important versioning information included in CDA 
Validation Plus.  As the software will continue to evolve and be refined, multiple versions of 
the software will be released.   
To access the Help menu items, click on the Help menu item, and select the desired sub-
option, or use the appropriate keystroke combination for the desired sub-option.  

 
The following table describes the CDA Validation Plus Help menu sub-options: 

Sub-option 
(Keystroke)  Toolbar Icon Function 

About (F10) 

 View CDA Validation Plus, Cancer 
IG, CDA versioning information, as 
well as contact information for 
inquires about the program 

The CDA Validation Plus CDA Document Validation Process 
CDA documents that are to be validated by CDA Validation Plus are the CDA documents 
reported by the physician EMR/EHR to the central cancer registry in the format specified by 
the Cancer IG. CDA is an XML document that consists of a header and a structured body. It 
is presented in this format: Header – includes patient information, author, creation date, 
document type, provider, etc. Body – includes diagnosis, patient details, medications, 
procedures, follow-up, etc. Information can be presented as free text in one or multiple 
sections, and also includes coded entries. 

Major Components of a CDA Document 
− A CDA document has a Header and a Body. 
− A CDA document Body is comprised of Sections. 
− A CDA Section contains one Narrative Block and zero to many Entries. 

o [1..1] Header 
o [1..1] Body 

− [1..*] Sections 
 [1..1] Narrative block 
 [0..*] Entries 
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Example of CDA XML Format Structure 

 

The CDA Validation Process  
CDA Validation Plus currently performs seven different types validation and includes both 
structural and content validation. All validation rules are based on the specifications 
identified in the Cancer IG. This tool is intended to be used in conjunction with, not as a 
substitute for, the HL7 CDA Cancer Registry Reporting Validation Tool (MU Stage 2) or the 
Cancer Report Validator (MU Stage 3) provided by the National Institute of Standards and 
Technology (NIST). The NIST validators were developed to evaluate conformance to the 
standards referenced by the Office of the National Coordinator for Health Information 
Technology (ONC) for cancer reporting.  

CDA Validation Plus does not perform the structural validation rules that are already 
handled by the NIST validators; rather it assumes that documents have already passed 
through the NIST validator with no errors. CDA Validation Plus performs validation rules 
that will improve the interoperability between EMR/EHR systems and the cancer registry 
tool(s) developed to process the cancer CDA reports. It is not intended to be used for EHR 
certification purposes.  
Content validation in CDA Validation Plus is based on the Value Sets and Code Systems 
identified in the Cancer IGs. Valid value sets for cancer reporting can be viewed and/or 
downloaded from the Public Health Information Network Vocabulary Access and 
Distribution System (PHIN VADS) at Meaningful Use Healthcare Provider Reporting to 
Central Cancer Registries. 
 

CDA Validation Process Steps and Validation Rules 
Once a CDA document has been imported or copied into CDA Validation Plus, the basic 
process of validating a CDA document is as follows:  

http://cda-validation.nist.gov/cda-validation/muCr.html
https://cda-validation.nist.gov/cda-validation/muCRV.html
http://phinvads.cdc.gov/vads/ViewView.action?name=Meaningful%20Use%20Healthcare%20Provider%20Reporting%20to%20Central%20Cancer%20Registries
http://phinvads.cdc.gov/vads/ViewView.action?name=Meaningful%20Use%20Healthcare%20Provider%20Reporting%20to%20Central%20Cancer%20Registries
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First the CDA document is checked for valid XML format structure, and then the following 
validation rules are applied to the CDA document and any invalid document structure, 
content, codes, and coding systems are identified: 

i. Critical missing required fields validation rule:  
a. Verifies that a subset of required data elements that are considered critical to 

cancer registries are present in the CDA document. 
b. Checks for a missing (empty) value of the data element as well as for a missing 

entire element (i.e., the Xpath for the data element is not found).  
c. Identifies critical required fields that are either missing from the CDA document 

or are structurally invalid.  
ii. Missing required field validation rule:  

a. Verifies that required data elements are present and are structurally valid. 
b. Checks for a missing (empty) value of the data element as well as for an entirely 

missing element (i.e., the Xpath for the data element is not found). 
c. Identifies required data elements that are either missing from the CDA 

document or are structurally invalid.  
iii. Invalid or unexpected null flavor validation rule:  

a. Verifies that data elements that are either required to or expected to have non-
null values do in fact contain non-null values. 

b. Identifies missing values or unexpected null flavors for required data elements.   
iv. Invalid Code System Object Identifier (OID) validation rule:  

a. Verifies that Code System OIDs are valid for their given coded data element. 
b. Identifies Code System OIDs that are not valid for a given coded data element. 

i. Displays valid Code System OIDs when an invalid one is provided 
in the document.   

v. Invalid values validation rule:  
a. Uses look up tables to validate values for the specified Value Set(s) allowed for 

coded data elements. 
b. Identifies values that are not valid according to the Value Set(s) allowed for 

coded data elements. 
vi. Check formatting validation rules and identifies any of these data items that have an 

invalid format: 
a. Social security numbers (SSN) 

All SSNs are exactly 9 digits long, and are in the format "xxx-xx-xxxx" or 
"xxxxxxxxx", or “xxx xx xxxx”, where "x" is a numeric digit (0 through 9). In 
either form the first three digits are referred to as the "Area Number", the 
middle two digits are the "Group Code" and the final four digits are the "Serial 
Number". 

i. Valid formats: “xxx-xx-xxxx”, “xxxxxxxxx” and “xxx xx xxxx”. 
ii. The area numbers “000” and “666” are invalid (based on Social 

Security Administration assignment rules).  
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iii. All numbers between "900" and "999" are invalid (based on Social 
Security Administration assignment rules). 
 

b. Dates 
i. Invalid date formats: 

1. Cannot be greater than 14 digits. 
2. Cannot be odd number of digits. 
3. Cannot be 2 digits. 
4. 1, 2, 3, 5, 7, 9, 11, 13 and greater than 14 digits are invalid 

formats. 
ii. Valid date formats: 

1. Date should have an even number up to 14 digits. 
2. 4, 6, 8, 10, 12, 14 digits are valid formats. 
3. YYYYMMDDHHMMSS +/-[ZZzz]  where +/-[ZZzz] is 

optional time zone offset. Time zone offset when given 
should be exactly 4 digits. If anything followed by +/- is 
less than 4 digits it is invalid. 

c. NPI numbers (10 numeric digits) 
i. Physician NPI can be reported in any of 3 areas in the CDA 

Document. CDA Validation Plus should only produce an error 
when all 3 of these CDA data elements are empty.  

 
ii. If Author NPI AND Physician NPI (Service Event) AND 

Physician NPI (Encompassing Encounter) are empty (missing OR 
null flavor), produce a “Missing required field” error type; error 
level “Error”; and the following error message: “The document 
does not contain any of the possible physician NPI numbers that 
map to the NAACCR NPI--Physician—Managing or NPI--
Physician--Follow Up” items.” 

d. CPT codes  
Valid formats for Code System OID == "2.16.840.1.113883.6.12": 

i. 5 numeric digits. 
ii. 5 numeric digits, followed by a dash, followed by 2 numeric digits. 

e. HCPCS codes 
Valid formats for Code System OID == 2.16.840.1.113883.6.285”: 

i. A single alphabetical letter followed by 4 numeric digits. 
ii. A single alphabetical letter, followed by 4 numeric digits, followed 

by a dash, followed by 2 characters (number or letter). 
vii. Cancer Reportability validation rule: 

a. Verifies that the cancer diagnosis entry represents a reportable cancer.  
b. Identifies any documents that may not represent a reportable cancer. 
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NOTE: Not all code systems/value sets are validated in the current version of this tool. Some 
may be added in future versions. The following validations are not currently being 
performed: 

1. Procedure Code (Related to results):  
a. CPT-4 (Code System OID: 2.16.840.1.113883.6.12) 
b. LOINC (Code System OID: 2.16.840.1.113883.6.1) 

2. Procedure Codes: 
a. CPT-4 (Code System OID: 2.16.840.1.113883.6.12) 
b. LOINC (Code System OID: 2.16.840.1.113883.6.1) 

3. Medication and Medication Administered Product Codes: 
a. RX Norm (Code System OID: 2.16.840.1.113883.6.88). RX Norm is updated 

on a very frequent basis, so the decision was made to remove validation of 
values in this code system from the tool. 

4. Type of Primary Payer at Dx Code 
a. X12 Insurance Type Code (Code System OID: 2.16.840.1.113883.6.255.1336 

and 2.16.840.1.113883.6.255) 

Missing Required Fields: XML Error Examples  
As stated earlier, “missing required field” errors can occur for one of three reasons:  

1) The value of the data element is missing (empty).  
a) The data element can be present, but the actual value missing, which will produce 

the error “[data element name] is not present or is structurally incorrect”.  
Example XML for string data type:  
    <patient> 
        <name> 
          <given>John</given> 
          <given>Jacob</given> 
          <family></family> 
        </name> 
 
Example XML for a coded data element (attribute “code” is missing): 
        <administrativeGenderCode codeSystem="2.16.840.1.113883.5.1" 
codeSystemName="HL7 Administrative Gender"/>  
 

2) The entire element missing from the CDA document (i.e., the Xpath for the data 
element is not found).  
a) The entire data element can also be missing, which will produce the error “[data 

element name] is not present or is structurally incorrect”. 
Example XML with last name (“family”) missing: 
      <patient> 
        <name> 
          <given>John</given> 
          <given>Jacob</given> 
        </name> 

 
3) The structure of the data element is not valid according to the cancer CDA 

specifications.  
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a) If the Xpath for a data element is not found it may have an invalid structure. The 
Xpaths for elements within sections use one of the required section template IDs 
to uniquely identify sections. So, if an Xpath is missing, it could be due to a 
missing required template ID.  The following example will produce the error 
“Active Problem Start Date is not present or is structurally incorrect”, even 
though the Active Problem Start Date is present, because the required template ID 
1.3.6.1.4.1.19376.1.5.3.1.3.6 is not present:  

 
Example XML: 
        <section classCode="DOCSECT" moodCode="EVN"> 
          <templateId root="2.16.840.1.113883.10.20.22.2.5.1" /> 
          <id root="xxx" /> 
          <code code="11450-4" codeSystem="2.16.840.1.113883.6.1" 
codeSystemName="LOINC" displayName="PROBLEM LIST" /> 
          <title>Problems</title> 
          <text>Cancer Dx test</text> 
          <entry typeCode="DRIV"> 
            <act classCode="ACT" moodCode="EVN"> 
              <templateId root="2.16.840.1.113883.10.20.22.4.3" /> 
              <id root="yyy" /> 
              <code nullFlavor="NA" /> 
              <statusCode code="completed" /> 
              <effectiveTime> 
                <low value="20130911144901" /> 
                <high value="20130911144901" /> 
              </effectiveTime> 

 
b) The Xpath also may not be found because there is an incorrect, missing, or extra 

act/entry/entry relationship/qualifier, etc.  The following example will produce the 
error “Active Problem Start Date is not present or is structurally incorrect”, 
because the Xpath cannot be found due to an incorrect act type (“observation” 
instead of “act”):  

Example XML: 
       <section> 
          <templateId root="2.16.840.1.113883.10.20.1.11" /> 
          <templateId root="1.3.6.1.4.1.19376.1.5.3.1.3.6" /> 
          <templateId root="1.3.6.1.4.1.19376.1.7.3.1.3.14.1" /> 
          <id root="abc123" /> 
          <code code="11450-4" displayName="Problem List" 
codeSystem="2.16.840.1.113883.6.1" codeSystemName="LOINC" /> 
          <title>Cancer Diagnosis</title> 
           <text>Malignant neoplasm of prostate</text> 
          <entry typeCode="DRIV"> 
            <observation classCode="OBS" moodCode="EVN"> 
              <templateId root="2.16.840.1.113883.10.20.1.27" /> 
              <templateId root="1.3.6.1.4.1.19376.1.5.3.1.4.5.1" /> 
              <templateId root="1.3.6.1.4.1.19376.1.5.3.1.4.5.2" /> 
              <id root="def456" /> 
              <code nullFlavor="NA" /> 
              <statusCode code="active" /> 
              <effectiveTime> 
                <low value="20120402" /> 
              </effectiveTime> 
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Critical Missing Required Fields versus Required Missing Fields 
When the error “Missing required field” is issued, the errant data element is indicated as a 
“critical field” or a “required field”.  Data elements denoted as “critical required” are a subset 
of required data elements that are considered critical to cancer registries, and are required to 
be included in the CDA document. Data elements denoted as “required” are a subset of 
required data elements that are usually required by cancer registries, but that are not formally 
required to be included in the CDA document. 
As a result, vendors and cancer registries need to assess all Missing Required Field errors 
based on the type of error message; “critical missing” or “required missing” and for those 
data elements identified as required missing, errors should be assessed for reason the error is 
generated and followed up by the registry accordingly: 

1. The value of the data element is missing (empty).  
2. The entire element missing from the CDA document (i.e., the Xpath for the data 

element is not found).  
3. The structure of the data element is not valid according to the cancer CDA 

specifications.  
 

Items 2 and 3 are structural errors that have to be corrected, however an error based on item 1 
might be acceptable depending on the identified data element. 

 

CDA Validation Plus was designed to help registries and vendors to optimize the 
CDA document as a reporting source for cancer registries, as well as with the 
on-boarding process. With the exception of identified missing required data 
elements and unexpected null flavors, all other errors identified by the 
application must be corrected. Registries may want to take advantage of the 
automatically-generated Excel-formatted Validation Report, adding an 
additional column to indicate whether the identified error is required by the 
registry to be fixed and forwarding to the submitting vendor/organization.  

Error Levels 
CDA Validation Plus has the ability to distinguish between different levels of error. There 
are four error levels: Critical, Error, Warning, and Info. For every error type there is an 
assigned error level. This new feature has been added to help registries better prioritize issues 
identified in testing.  

 

Error Level Description 

Critical Error This is a required field and must be completed.  

Error This field should be completed in most cases. Frequent errors of 
the same type can help identify patterns from the same 
provider.    

Warning This field is not as critical; shouldn’t delay testing. Frequent 
errors of the same type can help identify patterns from the same 
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provider. 

Info For information purposes only; shouldn’t delay testing. 

 
For example, Patient's Medical Record Number is not a critical data element for Stage 3, but 
does have an Error level type for Missing Required Field; therefore, if this field is missing 
the validation report will display an Error Type of Missing Required Field and an Error Level 
of Error:  

 
This feature has been added to the Validation View, Report Viewer and Excel Report (shown 
above). 
 
Validation View 

 
 
Report Viewer 

 
 
CDA Validation Plus will determine the success or error based on error level. Once the file is 
processed, the tool will place the reports in the appropriate folder. The “Errors” folder will 
contain files that have at least one Critical or Error level errors. The “Warning_Info_Only” 
folder will contain files that only have warning and/or info level errors. The Success and 
Unprocessed_Files will remain the same (as described further below). 
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Repeating Fields 
(See release notes for known issues related to Repeating Fields) 
Many data elements can occur more than once in a single CDA document; we refer to these 
as “repeating fields”. For example, two cancer diagnoses will be reported in the same 
document. In this case, there will be two histology codes, two primary sites, etc. Rules have 
been developed to provide error messages for various error types given different scenarios 
for repeating fields.  
Note: when a repeating element has errors on two or more instances, you may see multiple 
errors with the same message.   
The following rules are applied for repeating fields. The table in Appendix C identifies which 
data elements follow which rules.  
 

i. Missing Required Field:  
If at least one of the repeats has a value, the tool does not produce any error. If all of the 
repeats are missing, the tool produces one Missing Required Field error.  (Tool treats 
both the missing XPath as well as value in the XPath missing as the same for this error 
type). If all of the repeats have no values but have Null Flavors, the tool does not 
produce any error. 

ii. Missing Required Field and Invalid Value:  
If the XPath is missing, the tool produces one Missing Required Field error message. 
For “Missing Required Field” error types, if the value in the XPath is missing, the tool 
does not produce any error. For “Invalid Value” error type, the tool produces the 
Invalid Value error for every repeat where the value in the XPath does not match any of 
the valid values in the lookup table. 

iii. Missing Required Field and Invalid Value and Null Flavor:  
If the XPath is missing, the tool produces one Missing Required Field error. If the 
XPath is given then:  
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a. The tool checks to see if there is any Null Flavor given; if the element has a 
Null Flavor, the tool produces one Null Flavor error message. (Only one Null 
Flavor error is produced for all the Null Flavors given in the message)  

b. If the XPath has no Null Flavor only, the tool checks for the value in the XPath; 
when there is no value for every repeat the tool produces a Missing Required 
Field error. 

c. If the XPath has a value, the tool checks to see if that value is in the lookup 
table; if the value does not match any of the valid values in the lookup table, 
then for every repeat the tool produces the Invalid Value error. 

iv. Missing Required Field and Null Flavor (Non-Cancer Section): 
For all sections other than the Cancer Diagnosis Section, the tool produces a Missing 
Required Field error for every missing field (missing XPath or empty values in the 
XPaths). If all of the repeats have Null Flavors, the tool produces only one Null Flavor 
error message. If at least one of the repeats has a value and the rest have Null Flavors, 
the tool does not produce any error. If some of the repeats have Null Flavors and some 
repeats are missing, the tool produces one Null Flavor error message. 

v. Missing Required Field and Null Flavor (Cancer Diagnosis Section): 
For data elements in the Cancer Diagnosis Section, for every repeat the tool checks to 
see if a value is given. If the value is missing, the tool checks for a Null Flavor and 
produces a Null Flavor error for every repeat where a Null Flavor is given, and a 
Missing Required Field error for the other repeats.  

vi. Missing Required Field and Null Flavor and NPI Number Formatting: 
For every repeat the tool checks to see if a value is given. If a value is missing, the tool 
checks for a Null Flavor and produces Null Flavor error for every repeat where a Null 
Flavor is given, and a Missing Required Field error for the other repeats. If a value is 
given, the tool checks for the format; if the format is not correct, the tool produces an 
NPI Number Formatting error. 

vii. Missing Required Field and Social Security Number Formatting: 
If the XPath is missing, the tool produces the Missing Required Field error message. If 
the XPath has some value, the tool checks the format for every repeat. If the format is 
wrong, the tool produces the SSN Formatting error.  

viii. Invalid Value: 
If the XPath has some value, the tool checks the lookup table to see if it’s a valid value. 
If the value is invalid, the tool produces the Invalid Value error for every repeat. If the 
value in the XPath is missing, the tool does not produce any error. 

ix. Invalid Code System OID: 
The tool produces an Invalid Code System OID error for every repeat where the OID is 
invalid. 

x. Invalid Code System OID and Invalid Value: 
For every repeat, the tool first checks to see if the given OID is valid. If the OID is 
invalid, the tool produces the Invalid Code System OID error. If the OID is valid, the 
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tool checks the lookup table to see if it’s a valid value; if the value is invalid, the tool 
produces the Invalid Value error for every repeat. 

xi. Date Formatting: 
If the XPath has some value, the tool checks the format to see if it has a valid date 
format. If the date is not in the valid format, the tool produces the Date Formatting error 
for every repeat. 

xii. Missing Required Field and Date Formatting: 
If a valid date or a Null Flavor is found in at least one of the repeats and the other 
repeats are missing, the tool does not produce any Missing Required Field error. If the 
date is missing in all of the repeats, the tool produces one Missing Required Field error. 
If the date is given, for every repeat the tool checks to see if the date is formatted 
correctly and produces an Invalid Date format error for every repeat where the date is 
not valid. 
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Validating CDA Documents 
As mentioned earlier, the primary function of CDA Validation Plus is to validate the 
structure, content, codes, and coding systems of CDA documents (based on XML) that are 
generated by EMR or EHR software systems and submitted to central cancer registries for 
the purposes of cancer reporting.   
To use CDA Validation Plus to validate a CDA document, complete these steps: 
1. Open the Validate Cancer CDA Document window. This can be done in 3 ways: 

a. Click on the File menu, and select Validate CDA Document. 

 
b. Use the keystroke Ctrl+M.  
c. Click on the                            Toolbar icon 

Result: The Validate Cancer CDA Document window opens.  
 

 
CDA Validation Plus offers four different options for loading an individual CDA 
document or multiple documents into the application for validation: 
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Validate CDA 
Document Option Function 

Select a document or 
multiple documents to 
validate 

Use this option if you are an EMR or EHR software vendor to 
browse to a test document or documents produced by your 
EMR/EHR software, or if you work in a central cancer registry use 
this option to browse to a test document or documents submitted 
to you from your EMR/EHR software vendor and upload into the 
application 

Select a folder to 
validate 

Use this option if you are an EMR or EHR software vendor to 
browse to a folder that contains multiple documents produced by 
your EMR/EHR software, or if you work in a central cancer 
registry use this option to browse to a folder that contains multiple 
documents submitted to you from your EMR/EHR software 
vendor and upload all documents in the specified folder into the 
application 

Copy and paste a 
document to validate 

Use this option if you would like to manually copy and paste a 
CDA document into the application document window 

Sample document to 
validate 

The application also comes with a couple of sample documents 
that you can validate in order to familiarize yourself with the 
program; select this option if you would just like to familiarize 
yourself with the validation process 

When the Validate Cancer CDA Document window opens, the Select a document or multiple 
documents to validate option is selected by default. 

Using the Select a Document(s) to Validate Option 
As mentioned earlier, CDA Validation Plus was designed to be used by EMR/EHR vendors 
to validate cancer CDA documents generated by their products and by central cancer 
registries to validate cancer CDA documents prior to subsequent processing in eMaRC Plus.  
As a result, the application provides the option for the user to upload single or multiple test 
documents produced by EMR/EHR vendor software, or to upload documents submitted to a 
cancer registry from their EMR/EHR software vendors into the application. 
 
To upload a single CDA document or multiple documents, complete these steps; 
1. On the Validate Cancer CDA Document window click Select a document or multiple 

documents to validate. 
2. Click Browse.   
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Result:  The Open CDA Document window opens (defaulted to the 
C:\RegPlus\CDAValidationPlus\IMPORTS folder, however, you can navigate to the 
Cancer CDA document location anywhere on your computer or network). 

3. Select the CDA document or documents that you would like to validate, and click Open. 
To select multiple documents to open, you can hold the Shift key down while left-
clicking on the documents you want to select. In the example shown, a single document 
being selected and imported and is named Physician_CDA.xml.  
Result:  You are returned to the Validate Cancer CDA Document window, where the 
name and path of the document selected for import is displayed.  

4. Click Validate.  
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Result:  The CDA ValidationView window opens where information on identified 
validation errors is displayed in the validation results grid.  

 
Each row displayed on the validation results grid represents a single CDA document and 
its validation results. If validating multiple CDA documents, multiple rows will be 
displayed. To view the actual Validation Report, double-click on the row of the CDA 
document for which you would like to view the report.  

The ValidationView results grid includes these rows: 

Column Description 
Status The file status, processed or unprocessed 
CDA Document Name The name and original file path of the CDA document  

Total The total number of validation errors (if any) found upon 
validation of the file 

Number of Critical 
Errors 

The total number of validation errors (if any) with Error 
Level of “Critical” 

Number of Errors The total number of validation errors (if any) with Error 
Level of “Error” 

Number of Warnings The total number of validation errors (if any) with Error 
Level of “Warning” 

Number of Info The total number of validation errors (if any) with Error 
Level of “Info” 

View Message Allows the user to view the raw CDA document by 
clicking on Raw Message 
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5. Click Raw Message.  
Result: The CDA Message View window opens, and by default displays the CDA in its 
raw XML format. A helpful text search is included in the window, so that once 
validation errors are identified, you can search the document for a specific term in order 
to view the errant portion of the document to assess exactly what is causing the error. 

 
The CDA Document View window also provides the option of viewing the document 
using a Tree View structure, which greatly facilitates the viewing of the document.  To 
view the document using the Tree View, click the Tree View tab. 



CDA Validation Plus General User Basics   CDA Validation Plus User Guide 

Version 4.0 May 2018  27 

 
The Tree View option allows the user to search the CDA document using the errant 
Xpath provided by the application (see below), so that once validation errors are 
identified, you can go directly to the Xpath that includes the errant portion of the 
document to assess exactly what is causing the error. Just copy and paste the errant Xpath 
into the Xpath box and click Get Value. Also, in the area where Xpath is entered, you 
have the ability to either clear the Xpath or double click and select the entire Xpath, to 
make it easier to enter a new one. 

6. Click Close to close the CDAView window.  
Result:  The CDAView window closes and you are returned to the ValidationView 
window. 
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7. Double-click on the row of the CDA document for which you would like to view the 

Validation Report.  
Result:  The CDA Document Validation Report opens in the CDA Validation Plus 
Report Viewer, where information on identified validation errors is displayed.   
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The CDA Validation Report 

 
The Validation Report window includes these sections and options: 

Section/Option Description 
Report Header The Validation Report header is located in the upper left-hand 

corner of the Validation Report and includes the name and 
original location of the imported CDA document and the date 
the report was run 

Validation Report 
Error Summary 
Information 
 

The Error Summary is located directly below the Report Header 
in the upper left-hand corner of the Validation Report and 
includes a summary of the number of validation errors 
identified by Error Type as well as the overall total number of 
identified errors 

Validation Report 
Error Section 
 

The Validation Error Section is listed below the Error Summary 
and includes a line listing of identified errors grouped by Error 
Type 
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The Validation Report Error Section 
The Validation Error Grid includes a line listing of identified errors that can be scrolled 
through vertically.  Errors are listed by Error type, Error level and the following information 
is included for each listed error: 

Column Description 

Data Element This column identifies the specific data element that has an 
error; please see Appendix B for a detailed listing of data 
elements assessed by each validation rule 

Error Message This column includes a detailed error message specific to the 
identified errant data element 

Error Type The Error Type is the overall type of error that was 
identified: 

− Critical Missing Required Field 
− Missing Required Field 
− Unexpected Null Flavor 
− Invalid Value  
− Invalid Code System OID 
− Formatting Errors 

 Social Security Number 
 NPI Number 
 Date 
 CPT Code 
 HPCPS Code 

− Cancer Reportability 

Error Level The Error Level identifies whether the Error Type is Critical, 
Error, Warning or Info 

Xpath This column displays the Xpath to the exact location of the 
error in the CDA document 
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Viewing Validation Reports – The Report Viewer Window 

 
The CDA Validation Plus Report Viewer window is divided into 2 main sections: a window 
in which to view reports on the left, and a pane for viewing report thumbnails on the right.  
When you left-click and hold your mouse on the vertical divider bar in the center of the 
window, a splitter appears which you can drag to the left or right to resize the view report 
and thumbnails views.   

The Main Toolbar 

 
The Report Viewer Main Toolbar includes icons to print and save the report being viewed, as 
well as modify the current view of the report.  The following table describes the function of 
each of the icons on the Main Toolbar, as well as listing keystroke equivalents where 
available for each function. 

Icon Keystroke Function 

 Ctrl+P Print the report being viewed; opens the print dialog 
window 

 Ctrl+O Save the report being viewed to various file formats 

Page 
Navigation 
Controls 

Can 
Resize 
Panes 

Main 
Toolbar 

Page View 
Controls 

Validation 
Report 
Summary 

  

Report 
Thumbnails 

Open 
Search 
Toolbar 
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Icon Keystroke Function 

 Ctrl+Shift+S Change report page setup: size, orientation and margins 

 Ctrl+B 

Show/hide the tree of bookmarks of the report being 
viewed; bookmarks are displayed by default---if there are 
no bookmarks in the report the Report Viewer will 
automatically hide the tree of bookmarks 

 Ctrl+T Show/hide the thumbnail view of reports in the pane on the 
right 

 Ctrl+F Search; Open the Search Toolbar 

 F2 View the report in full screen mode 

 F3 View the report one page at-a-time 

 F4 View the report 2 pages at-a-time 

 No keystroke View multiple pages of the report at-a-time; specify 1x2, 
2x3, etc. 

 F5 Control page width; when clicked report will enlarge to the 
page width of Report Viewer window 

 No keystroke Close a report  

Page Navigation Controls 

 
Report page navigation controls are located in the lower left-hand corner of the Report 
Viewer window and help you navigate through the various pages of the report being viewed. 
The following table describes the function of each of the page navigation controls. 

Control Function 

 
View the first page of the report being viewed 

 
View the previous page of the report being viewed 

 Lists the page number of the current page of the report being viewed 



CDA Validation Plus General User Basics   CDA Validation Plus User Guide 

Version 4.0 May 2018  33 

Control Function 

 View the next page of the report being viewed 

 
View the last page of the report being viewed 

The Search Toolbar 
The search panel is used to search for specific text within the report.  To access feature, click 
the binocular icon  on the main toolbar. 

 
When opened, the Search Toolbar is located in the lower left-hand corner of the Report 
Viewer window directly over the Page Navigation controls. The following table describes the 
function of each of the Search toolbar icons. 

Icon Function 

 Closes the Search Toolbar 

 
Enter the term being searched for in the Find What box 

 
When clicked, searches the report and finds the next 
occurrence of the search term entered in the Find What 
box 

 
When checked, the search is repeated with case of the 
search term considered 

 
When checked, the search is repeated with only whole 
words of the search term considered 

Page View Controls 

 
Report page view controls are located in the lower right-hand corner of the Report Viewer 
window, and include icons to help you control how many pages of the report to view, as well 
as to zoom in or out on the current report being viewed. The following table describes the 
function of each of the page view controls. 

Control Keystroke Function 

 Shift+F2 Single Page: View the report one page at-a- 
time 
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 Shift+F3 Continuous: View the report with all pages 
displayed continuously 

 Shift+F4 
Multiple Pages:  based on the selected 
zoom, all possible pages are displayed to 
fill the viewer window 

 No keystroke Selected Zoom:  View the report at the 
percent size specified  

Saving Reports 
In order to facilitate the utilization of the information included in the CDA Validation 
Report, CDA Validation Plus offers an extensive number of file formats in which the reports 
can be saved.  You can save the reports in different file formats in order to further analyze or 
format the data included differently, or you can save the report as an image file to be placed 
in documents and presentations. 
You can save the report in any of the file formats listed under the Save As icon on the Main 
Toolbar of the Report Viewer: 
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Document Copying and Auto-generating Excel Validation Report upon 
Validation 
When a CDA document or documents are validated using CDA Validation Plus, there will be 
1 of 3 outcomes: 

1. The CDA document(s) contains errors 
2. The CDA document(s) is valid and contains no validation errors 
3. The CDA document(s) cannot be read by CDA Validation Plus due to major issues 

with overall document format 
In order to facilitate the tracking of validation efforts, based on the validation results CDA 
Validation Plus automatically generates a copy of the validated documents and places an 
Excel-formatted and XML copies of the Validation Report to one of 4 subfolders in the 
C:\RegPlus\CDAValidationPlus\Reports folder, which are named Errors, Success, 
Warning_Info_Only and Unprocessed_Files. All the processed documents (except for the 2 
sample documents provided by the Validation tool and unprocessed documents) are copied 
from the original folder to the respective Reports folders (errors or success) after validation. 
For unprocessed documents a copy of the document is placed in the Unprocessed_Files 
folder. 
CDA Validation Plus has a default configuration to “keep” the files in the imports folder 
after processing. If you would like to change the configuration to move the files from the 
imports folder to the reports folder after processing, you’ll need to update the Configure File 
Options under Admin.  

 

 

The two sample CDA documents included with the application are NOT 
moved from the IMPORTS folder, enabling you to validate the sample 
documents as often as you wish.  
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If the CDA document contains any validation errors, a copy of the document and the Excel-
formatted report will be generated. Both will be placed in the 
C:\RegPlus\CDAValidationPlus\Reports\Errors folder: 

 
The Excel-formatted Validation Report generated for documents containing validation errors 
includes 4 worksheets, ErrorSummary, ErrorReport, ErrorSummaryWithLevels and 
ProviderNameAndNPI. The Error Summary worksheet refers to the Validation Report 
Error Summary information: 
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The Error Report worksheet refers to the Validation Report Error Section information: 

 
The Error Summary with Levels worksheet refers to the total error count with error levels.  
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The Provider Name and NPI worksheet displays the Author, Physician and 
Organization with NPI and Name.  

 

 

As mentioned earlier, registries may want to take advantage of the Excel-based 
Validation Report, formatting the report to make it more visually appealing and 
clarifying its contents, and adding an additional column as to whether the 
identified error is required by the registry to be fixed and forwarding to the 
submitting vendor/organization. 

If the CDA document is 100% valid and does not contain any validation errors, a copy of the 
document and the Excel-formatted report will be generated. Both will be placed in the 
C:\RegPlus\CDAValidationPlus\Reports\Success folder: 
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For the Excel-formatted Validation Report generated for documents containing no validation 
errors, the Error Summary worksheet will indicate that zero validation errors were identified, 
and the Error Report worksheet will display an empty report: 
 

 
 
If the document has formatting issues that prevent it from being read by CDA Validation 
Plus (e.g., not a valid XML file), the document will not be processed, and a copy of the 
document will be generated and placed in the C:\RegPlus\CDAValidationPlus\Reports\ 
Unprocessed_Files folder. 

Using the Copy and Paste a Document to Validate Option 
In addition to being able to upload a test document(s) produced by EMR/EHR vendor 
software, or to upload documents submitted to a cancer registry from their EMR/EHR 
software vendors, CDA Validation Plus allows you to manually copy and paste a CDA 
document into the application document window for validation. 
 
To copy and paste a CDA document for validation, complete these steps; 
1. On the Validate Cancer CDA Document window click Copy and paste document to 

validate. 
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2. Place your cursor into the document window, and paste the CDA document you would 

like to validate.   

 
3. Click Validate.   
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Result:  The CDA Document Validation Report opens in the CDA Validation Plus 
Report Viewer, where information on identified validation errors is displayed.   
Once you have the Validation Report open in the report viewer window, the application 
works in the same exact manner as for an uploaded document. Please click here or go to 
page 29 of this user guide to review the various features of the Validation Report. 

 

If you use the Copy and paste document to validate option, it is best to open the 
CDA document in a plain text or XML editor in order to copy/paste. Opening 
CDA documents in other programs such as a web browser sometimes results in 
introduction of invalid characters that will result in an “invalid XML” error. 

Using the Sample Document to Validate Option 
CDA Validation Plus comes with four sample documents that you can validate in order to 
familiarize yourself with the program, two that include some validation errors for MU2 and 
MU3, and two that are valid (no errors) for MU2 and MU3. The four documents are located 
in the C:\RegPlus\CDAValidationPlus\IMPORTS folder, and are named Example MU2 
Cancer CDA Message with Errors.xml, Example MU2 Valid Cancer CDA 
Message.xml, Example MU3 Cancer CDA Message with Errors.xml, Example MU3 
Valid Cancer CDA Message.xml 
To upload a sample CDA document provided with the application, complete these steps; 
1. On the Validate Cancer CDA Document window click the Sample documents to 

validate option button. 

 
Result:  The name and path of the four sample documents that come included in the 
program are automatically selected and displayed by the application (Example MU2 
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Cancer CDA Message with Errors.xml, Example MU2 Valid Cancer CDA 
Message.xml, Example MU3 Cancer CDA Message with Errors.xml, Example MU3 
Valid Cancer CDA Message.xml). 
 

2. Click Validate.  
Result:  The ValidationView window opens and displays a list of the validation reports 
that were generated, along with some helpful information like the document Status 
(Processed or Unprocessed), the path and filenames of the documents that were validated, 
as well as the number of validation errors identified (if any).   

 
Result:  The CDA ValidationView window opens where information on identified 
validation errors is displayed in the validation results grid. 
Once you have the ValidationView window open for the sample CDA documents, the 
application works in the same exact manner as for an uploaded document. Please click 
here or go to page 25 of this user guide to review the various features of the View 
Message features and Validation Report. 

 

The two sample CDA documents included with the application are NOT 
copied from the IMPORTS folder, enabling you to validate the sample 
documents as often as you wish.  

Using the Select Folder to Validate Option 
In order to enable batch processing of a large number of documents, CDA Validation Plus 
offers the option to browse to a folder that contains all of the CDA documents you would like 
to validate, and upload all documents in the specified folder into the application for 
validation. 
To upload all CDA documents in a user-specified folder, complete these steps: 
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1. On the Validate Cancer CDA Document window click the Select a folder to validate 
option button. 

2. Click Browse.  

 
Result:  The Browse for Folder window opens (defaulted to the 
C:\RegPlus\CDAValidationPlus\IMPORTS folder. You can browse to the folder in 
which the all of CDA documents you would like to validate are located. 

3. Select the appropriate folder and click OK. 
Result:  You are returned to the Validate Cancer CDA Document window, where the 
name and path of all of the CDA documents in the specified folder are displayed.  
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4. Click Validate.  

Result:  The Validation View window opens and displays a list of the validation reports 
that were generated, along with some helpful information like the document Status 
(Processed or Unprocessed), the path and filenames of the documents that were validated, 
as well as the number of validation errors identified (if any).   
Once you have the ValidationView window open for the CDA documents located in the 
folder selected to validate, the application works in the same exact manner as for an 
uploaded document. Please click here or go to page 25 of this user guide to review the 
various features of the View Message features and Validation Report. 

Running CDA Validation Plus from the DOS Command Line  
To enable interaction with other programs, the DOS command line interface can be used 
to run CDA Validation Plus to validate CDA documents. Once the appropriate DOS 
command has been executed, the processing of the documents is similar to that when 
using the Select Folder to Validate Option or Select a Document Option. In order to 
validate CDA documents using the DOS command line, all the CDA documents to be 
validated should be located in a single folder. 
To use the DOS command line prompt to validate CDA documents, complete these steps: 

1. Open the DOS command prompt window. 

a. On Windows XP:  
i. Click on Start then select Run. 

ii. Type cmd in Open box and press Enter. 

b. On Windows Vista/ Windows 7/ Windows 8.0/Windows server:  
i. Type cmd in the Start---> Run box. 
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ii. Press the keystrokes Ctrl+Shift+Enter (this will open the command 
prompt in Administrator mode). 

2. At the command prompt, type cd\ and press Enter to go to the root directory (i.e., C:\) 
3. Type cd RegPlus\CDAValidationPlus and press Enter. 

4. Import from a folder or import a single file: 
a. Importing from a folder: 

Type the following command and press Enter. 
>cancercdavalidationtool.exe action=validate importpath=XX reportpath=YY 
Where XX=the path to the folder where the CDA documents are located, and YY=the 
path to the folder to which you would like the application to copy the validated 
documents and the generated Excel-formatted Validation Reports. Please note that the 
above exact syntax must be used, including spaces where designated. 

Example: 
cancercdavalidationtool.exe action=validate 
importpath=C:\RegPlus\CDAValidationPlus\IMPORTS 
reportpath=C:\RegPlus\CDAValidationPlus\REPORTS 
Please see the above example in the DOS command window: 

 
 

b. Importing a single file: 
To specify a file instead of a folder for processing, you would type the following 
command and press ENTER. 

Type the following command and press Enter. 
>cancercdavalidationtool.exe action=validate importpath=ZZ reportpath=YY 
Where ZZ=the path including file name where the CDA document is located, and 
YY=the path to the folder to which you would like the application to copy the validated 
documents and the generated Excel-formatted Validation Reports. Please note that the 
above exact syntax must be used, including spaces where designated. 

 
C:\RegPlus\CDAValidationPlus>cancercdavalidationtool.exe action=validate 
importpath=C:\RegPlus\CDAValidationPlus\IMPORTS\NameOfFile.xml 
reportpath=C:\RegPlus\CDAValidationPlus\REPORTS 
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Note: The file name cannot have spaces due to DOS file name restrictions.  
 
After the validation process has run, CDA Validation Plus copies the CDA documents 
that were run through the application and, for valid and errant documents, generates and 
Excel-formatted copy of each Validation Report and places them in the appropriate sub-
folder in the C:\RegPlus\CDAValidationPlus\Reports folder. Please see Document 
Copying and Auto-generating Excel Validation Report upon Validation on page 35 of 
this guide for further information regarding this process.  
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Chapter 3: CDA Validation Plus Application Folders  
Learning Objectives 
In this chapter, you will: 

• Learn about the location and content of the various CDA Validation Plus application 
folders  

Overview 
This chapter describes the application folders that are generated upon installation of CDA 
Validation Plus.   

CDA Validation Plus Set up 
Upon installation, the default folder in which CDA Validation Plus is installed is the 
C:\RegPlus\CDAValidationPlus folder.  
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In addition to the application’s .exe file, the main application folder includes the following 
sub-folders: 

Sub-folder Description of Contents 
IMPORTS The IMPORTS folder is the default location of CDA 

documents to be imported into the program: 
− When you select the Upload a document to validate 

option on the CDA Validation window, the application 
opens to the IMPORTS folder by default 

− This is also where the sample CDA documents are 
located; when you select the Sample document to 
validate option on the CDA Validation window, the 
application automatically uploads the two sample 
documents in the IMPORTS folder  

MANUAL This user guide is included with CDA Validation Plus; upon 
installation of the application this guide, 
CDA_Validation_Plus_V4_0_User Guide.pdf, is placed in 
the MANUAL folder 

MDBS CDA Validation Plus uses a Microsoft Access database 
(Cancer_Validation.mdb) to ascertain the type of validation 
rule to apply to each data element validated in the CDA 
document; in addition the database also includes information 
on the Xpaths used to parse out the data elements from the 
CDA document 

REPORTS 
 

This sub-folder serves as the default location in which to save 
generated Validation Reports; based on the CDA document 
validation results CDA Validation Plus automatically copies 
the validated documents and generates an Excel-formatted 
copy of the Validation Report to the appropriate subfolders in 
the C:\RegPlus\CDAValidationPlus\Reports folder, which 
are named Errors, Warning_Info_Only, Success, and 
Unprocessed_Files.   
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Chapter 4: CDA Validation Plus Database Structure 
Learning Objectives 
In this chapter, you will: 

• Learn about the structure and content of the CDA Validation Plus Access database   

Overview 
This chapter describes the structure and content of the Cancer_Validation.mdb Access 
database against which CDA Validation Plus runs. 

The CDA Validation Plus Access Database 
CDA Validation Plus runs against a Microsoft Access database to identify the types of 
validation rules to apply to the various data elements being validated. The application also 
uses Xpath as the basis for parsing the data elements from the CDA document in order to 
validate them. The main table in the database referenced when validating CDA documents 
presented to the application are the CDAMAP_MU2 and CDAMAP_MU3 tables. 

 
 
The Xpaths for the data elements can be found in the CDAMAP tables in the database in the 
“XPATH” column. The name of the data element being validated can be found in the 
“LABEL” and/or “LABELFORVALIDATION” columns. The “VALIDVALUES” column 
identifies the valid code system OIDs for coded elements and the table name that identifies 
the valid values for each valid code system OID identified. The OID is listed first, then a pipe 
(“|”) delimiter, followed by the corresponding table name. If more than one valid OID is 
allowed, the OID|table name pairs are separated by a semi-colon.  
The validation tables identified in the “VALIDVALUES” column can also be viewed in the 
database and are all named beginning with a prefix of either Valid_ or Trans_. Each 
validation table includes an HL7CODE column (valid codes) and Concept Name column.  
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The “ERRORMESSAGE” column in the CDAMAP tables indicates the error message(s) that 
will appear in the validation report. Where more than one validation rule type is applied to 
the same data element, the error messages are separated by pipe delimiters. The 
“ERRORTYPE” column indicates the validation rule type(s) that are applied to the data 
element. Where more than one validation rule type is applied to the same data element, the 
error types are separated by pipe delimiters. The “ERRORLEVEL” column indicates the 
level of error (Critical, Error, Warning or Info) for the data element and validation rule type. 
Where more than one validation rule type is applied to the same data element, the error types 
are separated by pipe delimiters. 

Resolving Identified Errors 
With the detailed information included in the Validation Report, error messages, Xpaths, and 
Access database, EMR/EHR vendors should be able to determine the cause for any identified 
errors in the CDA documents that their products generate. To obtain answers to questions 
regarding error resolution, contact cancerinformatics@cdc.gov for technical assistance. 

 

DO NOT make ANY CHANGES to the content of the CDAMAP tables or 
any of the validation tables, as this may lead to interference in correction of 
identified data problems and/or erroneous identification of errors where the 
data are actually valid. Communicate any identified revisions to CDC 
immediately and we will address them in-house. CDC will not support any 
user changes to the tables with upgrades, as with every new release of the 
software the CDAMAP table will be overwritten with the latest version.  

mailto:CancerEHRReporting@cdc.gov
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Chapter 5: Software Updates 
Learning Objectives 
In this chapter, you will: 

• Learn about how to assess if you have the latest version of CDA Validation Plus 

• Learn how to obtain the latest version of CDA Validation Plus  

Overview 
This chapter covers information about keeping your CDA Validation Plus software up-to-
date. 

Software Updates 
CDA Validation Plus will be continually refined and enhanced based on newly released 
versions of MU Guidelines and HL7 CDA, as well as functionality needs of, and feedback 
from, end users. CDC NPCR welcomes feedback from all users of the program. Existing 
validation rules will be enhanced and new rules will be added as feedback is received. As a 
result, you will want to ensure that you keep the software current on your computer or 
network. 
New versions of the software will be released frequently, and will be announced to all 
registered users of the software via e-mail.   
If you would like to become a registered user of the software and receive download and 
software update information for CDA Validation Plus, please email a request to Lindsay 
Ryan at viu3@cdc.gov with the following information: 

• Name, email address, and phone number of Organization/Vendor/State/Program 
making the request (e.g. NYSCR, Epic) 

• If an EHR vendor, provide the name of your physician EHR software that will be 
transmitting cancer reports 

• Name, email address, and phone number of person installing/using the tool 
In order to make sure you have the most up-to-date version of the software, check the 
software version number and release date in the update e-mail received and compare that to 
the software version and the release date of your currently installed version of the software. 
To check for the version of CDA Validation Plus that you currently have installed on your 
computer, complete these steps: 
1. Open the About window.  This can be done in two ways: 

a. From Help Menu, select About. 

 
b. Use the keystroke F10.  
Result:  The About window opens.  

mailto:viu3@cdc.gov
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The About window lists CDA Validation Plus, Cancer IG, and CDA versioning 
information, as well as contact information for questions about the software. 

2. Note the CDA Validation Plus Version and release date, and double-check this with the 
latest version available on the FTP site. 

3. If your currently installed version is out of date, please contact Lindsay Ryan at 
viu3@cdc.gov to obtain the latest version of the software. 

4. If you have a previously installed version of the program, you must first uninstall that 
version and then install the latest version. Please note that uninstalling the previous 
version will not delete any reports already generated. 

 

 

mailto:viu3@cdc.gov
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Appendix A: Standard Keyboard Shortcuts 
Menus and Sub-options  Keyboard Combination 

File Menu Alt+ F 

Validate CDA Document Ctrl+ M 

Exit Alt+F4 

Utilities Menu Alt+ U 

Look-up code Definitions… Ctrl+L 

Help Menu Alt+ H 

               About F10 
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Appendix B: Data Elements/OIDs Checked 

Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

Critical Missing 
Required Field 

Date/Time of Report 
Patient's First Name 
Patient's Last Name 
Patient's Gender Code 
Patient's Date of Birth 
Diagnosis Date 
Histology Code 
Behavior Code 
Laterality Code 
Primary Site Code 
Histology Code System OID 
Behavior Code System OID 
Laterality Code System OID 
Primary Site Code System OID 

Date/Time of Report 
Patient's First Name 
Patient's Last Name 
Patient's Gender Code 
Patient's Date of Birth 
Diagnosis Date 
Histology Code 
Behavior Code 
Laterality Code 
Primary Site Code 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

Missing Required Field Patient's Middle Name 
Patient's Street Address 
Patient's City 
Patient's State 
Patient's Zip code 
Patient's Country 
Patient's Address Start Date 
Patient's Address End Date 
Patient's Phone Number 
Patient's Social Security 
Number 
Patient’s Medical Record 
Number 
Patient’s State of Birth 
Patient’s Country of Birth 
Patient's Race Code 
Patient's Ethnicity Code 
Patient's Marital Status Code 
Author First Name 
Author Last Name 
Author Name 
Author Street Address 
Author City 
Author State 
Author Zip Code 
Author Telephone # 
Reporting Organization Name 
(Custodian) 
Reporting Organization Street 
Address  (Custodian) 
Reporting Organization City 
(Custodian) 
Reporting Organization State 
(Custodian) 
Reporting Organization NPI 
(Custodian) 
Reporting Organization Zip 
Code (Custodian) 
Reporting Organization 
Telephone # (Custodian) 
Occupation Code 
Industry Code 
Smoking Status Code 
Diagnostic Confirmation Code 
Active Problem Code 
Active Problem Start Date 

Patient's Middle Name 
Patient's Street Address 
Patient's City 
Patient's State 
Patient's Zip code 
Patient's Country 
Patient's Phone Number 
Patient's Address Start Date 
Patient's Address End Date 
Patient's Medical Record 
Number 
Patient's Social Security 
Number 
Patient's State of Birth 
Patient Country of Birth 
Patient's Marital Status Code 
Patient's Race Code 
Patient's Additional Race 
Code 
Patient's Ethnicity Code 
Author Name 
Author First Name 
Author Last Name 
Author Street Address 
Author City 
Author Zip Code 
Author Telephone # 
Author State 
Author Country 
Smoking Status Code 
Reporting Organization NPI 
(Custodian) 
Reporting Organization Name 
(Custodian) 
Reporting Organization Street 
Address (Custodian) 
Reporting Organization City 
(Custodian) 
Reporting Organization 
Telephone # (Custodian) 
Type of Primary Payer at 
Diagnosis Code 
Assessment Narrative 
Occupation Code 
Industry Code 
Diagnostic Confirmation 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

Progress Notes (text) 
Radiation Oncology Narrative 
TNM Clinical T Code  
TNM Clinical N Code 
TNM Clinical M Code 
TNM Clinical Stage Group 
Code 
 
 

Code 
Problem Code 
Procedure Code 
Medication Product Code 
Medication Start Date 
Medication Administered 
Product Code 
Medication Administered 
Start Date 
Problem Start Date 
Procedure Start Date 
TNM Pathologic T Code 
TNM Pathologic N Code 
TNM Pathologic M Code 
TNM Clinical T Code  
TNM Clinical N Code 
TNM Clinical M Code 
TNM Clinical Stage Group 
Code 
Grade Code 
TNM Pathologic Stage  
Group Code 
Procedure Reason ID 
Medication Administered 
Reason ID 
Cancer Diagnosis Link to 
Problem ID 
Document Version Number 
Medication Reason ID 
Set ID 
Software Name 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

Invalid/unexpected Null 
Flavor 

Date/Time of Report 
Patient's First Name 
Patient's Last Name 
Patient's Street Address 
Patient's Zip code 
Patient's Gender Code 
Patient's Date of Birth 
Patient's Medical Record 
Number 
Patient's Race Code 
Patient’s Ethnicity Code 
Reporting Organization NPI 
(Custodian) 
Diagnosis Date 
Histology Code 
Behavior Code 
Diagnostic Confirmation Code 
Primary Site Code 
Laterality Code 
Active Problem Code 

Patient's First Name 
Patient's Last Name 
Patient's Street Address 
Patient's City 
Patient's State 
Patient's Zip code 
Patient's Country 
Patient's Phone Number 
Patient's Gender Code 
Patient's Date of Birth 
Patient's Medical Record 
Number 
Patient's Race Code 
Patient's Ethnicity Code 
Patient's Additional Race 
Code 
Patient's Social Security 
Number 
Patient's State of Birth 
Patient Country of Birth 
Patient's Marital Status Code 
Author Name 
Author First Name 
Author Last Name 
Reporting Organization 
Telephone # (Custodian) 
Reporting Organization Name 
(Custodian) 
Occupation Code 
Industry Code 
Diagnosis Date 
Primary Site Code 
Laterality Code 
Histology Code 
Behavior Code 
Diagnostic Confirmation 
Code 
Problem Code 
Procedure Code 
Grade Code 
Medication Product Code 
Medication Administered 
Product Code 
Problem Start Date 
Procedure Start Date 
Problem ID 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 
Procedure Reason ID 
Medication Administered 
Reason ID 
Cancer Diagnosis Link to 
Problem ID 
Medication Reason ID 
Date/Time of Report 
Document Version Number 
Set ID 
Software Name 

Invalid Code System 
OID 

Patient's Gender Code System 
OID 
Patient's Race Code System 
OID 
Patient's Additional Race Code 
System OID 
Patient's Ethnicity Code System 
OID 
Patient's Marital Status Code 
System OID 
Occupation Code System OID 
Industry Code System OID 
Smoking Status Code System 
OID 
Type of Primary Payer at 
Diagnosis Code System OID 
Histology Code System OID 
Behavior Code System OID 
Diagnostic Confirmation Code 
System OID 
Primary Site Code System OID 
Laterality Code System OID 
TNM Clinical Stage Group 
Code System OID 
TNM Clinical Stage Descriptor 
Code System OID 
TNM Edition Code System 
OID 
TNM Clinical Staged By Code 
System OID 
TNM Clinical T Code System 
OID 
TNM Clinical N Code System 

Patient's Gender Code System 
OID 
Patient's Race Code System 
OID 
Patient's Additional Race 
Code System OID 
Patient's Ethnicity Code 
System OID 
Patient's Marital Status Code 
System OID 
Physician Specialty (Service 
Event) Code System OID 
Physician Specialty Code 
System OID (Encompassing 
Encounter) 
Occupation Code System 
OID 
Industry Code System OID 
Smoking Status Code System 
OID 
Type of Primary Payer at  
Patient's Gender Code System 
OID 
Patient's Race Code System 
OID 
Patient's Ethnicity Code 
System OID 
Patient's Additional Race 
Code System OID 
Histology Code System OID 
Behavior Code System OID 
Diagnostic Confirmation 
Code System OID 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

OID 
TNM Clinical M Code System 
OID 
Active Problem Code System 
OID 
Procedure Code System OID 
(Related to Results) 
Procedure Code System OID 
Site of Procedure Code System 
OID 
Medication Product Code 
System OID 
Medication Administered 
Product Code System OID 
 

Primary Site Code System 
OID 
Laterality Code System OID 
TNM Clinical Stage Group 
Code System OID 
TNM Clinical Stage 
Descriptor Code System OID 
TNM Clinical Staged By 
Code System OID 
TNM Pathologic Staged By 
Code System OID 
TNM Pathologic T Code 
System OID 
TNM Pathologic N Code 
System OID 
TNM Pathologic M Code 
System OID 
TNM Pathologic Stage Group 
Code System OID 
TNM Pathologic Stage 
Descriptor Code System OID 
TNM Clinical T Code System 
OID 
TNM Clinical N Code System 
OID 
TNM Clinical M Code 
System OID 
Procedure Code System OID 
Site of Procedure Code 
System OID 
Medication Product Code 
System OID 
Medication Administered 
Product Code System OID 
Occupation Code System 
OID 
Industry Code System OID 
Author Specialty Code 
System OID 
Problem Code System OID 
Smoking Status Code System 
OID 
Grade Code System OID 
Radiation Regional Treatment 
Modality Code System OID 
Radiation Boost Modality 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 
Code System OID 
System OID 
Family Member Code System 
OID 
Family Member Problem 
Code System OID 
Health Status Code System 
OID 
Vital Sign Type Code System 
OID 
 

Invalid Value Patient’s City 
Patient’s State 
Patient’s Country 
Patient’s State of Birth 
Patient’s Country of Birth 
Reporting Organization 
Country (Custodian) 
Physician State (Service Event) 
Physician Country (Service 
Event) 
Physician State (Encompassing 
Encounter) 
Physician Country 
(Encompassing Encounter) 
Organization State 
(Encompassing Encounter) 
Author State 
Author Country 
Occupation Code 
Industry Code 
Smoking Status Code 
Type of Primary Payer at 
Diagnosis Code 
Histology Code 
Behavior Code 
Diagnostic Confirmation Code 
Primary Site Code 
Laterality Code 
TNM Clinical Stage Group 
Code 
TNM Clinical Stage Descriptor 
Code 
TNM Edition Code 
TNM Clinical Staged By Code 

Patient's City 
Patient's State 
Patient's Country 
Patient's State of Birth 
Patient Country of Birth 
Reporting Organization 
Country (Custodian) 
Physician State (Service 
Event) 
Physician Country (Service 
Event) 
Provider Referred to State 
Provider Referred to Country 
Reporting Organization State 
(Custodian) 
Physician State 
(Encompassing Encounter) 
Physician Country 
(Encompassing Encounter) 
Author State 
Author Country 
Author Organization State 
Author Organization Country 
Organization State (Service 
Event) 
Organization Country 
(Service Event) 
Physician Organization State 
(Encompassing Encounter) 
Physician Organization 
Country (Encompassing 
Encounter) 
Is Patient Deceased? 
(True=Yes) 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

TNM Clinical T Code 
TNM Clinical N Code 
TNM Clinical M Code 
Active Problem Code 
Procedure Code (Related to 
Results) 
Procedure Code 
Site of Procedure Code 
Medication Route Code 
Medication Site  Code 
Medication Administered Route 
Code 
Medication Administered Site 
Code 
Provider Referred to State 
Provider Referred to Country 
Organization Referred From 
State 
Organization Referred From 
Country 
Author Organization State 
Author Organization Country 
Organization State (Service 
Event) 
Organization Country (Service 
Event) 

Invalid Value in Code 
System  

Patient's State 
Patient's Country 
Patient's Gender Code  
Patient's State of Birth 
Patient Country of Birth 
Patient's Marital Status Code  
Author State 
Author Country 
Author Organization State 
Author Organization Country 
Reporting Organization State 
(Custodian) 
Reporting Organization 
Country (Custodian) 
Physician Specialty (Service 
Event) Code  
Physician State (Service Event) 
Physician Country (Service 
Event) 
Organization State (Service 

Patient's Gender Code 
Patient's Race Code 
Patient's Additional Race 
Code 
Patient's Ethnicity Code 
Patient's Marital Status Code  
Physician Specialty (Service 
Event) Code  
Vital Sign Type Code  
Primary Site Code  
Problem Code 
Smoking Status Code 
Medication Administered 
Product Code 
Medication Product Code 
Histology Code 
Behavior Code 
Diagnostic Confirmation 
Code 
Laterality Code 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

Event) 
Organization Country (Service 
Event) 
Physician Specialty Code 
(Encompassing Encounter) 
Physician State (Encompassing 
Encounter) 
Physician Country 
(Encompassing Encounter) 
Organization State 
(Encompassing Encounter) 
Organization Country 
(Encompassing Encounter) 
Provider Referred From State 
Provider Referred From 
Country 
Organization Referred From 
State 
Organization Referred From 
Country 
Provider Organization Referred 
to State 
Provider Organization Referred 
to Country 
Provider Referred to State 
Provider Referred to Country 

TNM Clinical Stage Group 
Code 
TNM Clinical Stage 
Descriptor Code 
TNM Pathologic Staged By 
Code 
TNM Pathologic N Code 
TNM Pathologic M Code 
Procedure Code 
Site of Procedure Code 
Physician Specialty Code 
(Encompassing Encounter) 
Occupation Code 
Industry Code 
Author Specialty Code 
Grade Code 
TNM Pathologic Stage Group 
Code 
TNM Pathologic Stage 
Descriptor Code 
TNM Clinical T Code 
TNM Clinical M Code 
TNM Clinical N Code 
TNM Pathologic T Code 
TNM Clinical Staged By 
Code 
Family Member Code 
Family Member Problem 
Code 
Health Status Code 
 

Invalid formatting 
(SSN, NPI & 
CPT/HCPCS) 

Patient's Social Security 
Number 
Author NPI  
Author Organization NPI  
Reporting Organization NPI 
(Custodian)  
Organization NPI (Service 
Event)  
Organization NPI 
(Encompassing Encounter)  
Provider Referred From NPI  
Organization Referred From 
NPI  
Provider Organization Referred 

Patient's Social Security 
Number 
Provider Referred From NPI 
Author NPI 
Reporting Organization NPI 
(Custodian) 
Physician NPI (Service 
Event) 
Physician NPI (Encompassing 
Encounter) 
Organization Referred From 
NPI 
Author Organization NPI 
Organization NPI (Service 
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

To NPI  
Provider Referred to NPI 
Procedure Performer NPI  
Procedure Organization 
Performer NPI  
Physician NPI (Service Event) 
Physician NPI (Encompassing 
Encounter) 
Procedure Code (Related to 
Results)  

• CPT (Code System 
OID= 
2.16.840.1.113883.6.12 

• HCPCS (Code System 
OID= 
2.16.840.1.113883.6.28
5 

Procedure Code 
• CPT (Code System 

OID= 
2.16.840.1.113883.6.12 

• HCPCS (Code System 
OID= 
2.16.840.1.113883.6.28
5 

 

Event) 
Organization NPI 
(Encompassing Encounter) 
Procedure Code 

• CPT (Code System 
OID= 
2.16.840.1.113883.6.1
2 

• HCPCS (Code System 
OID= 
2.16.840.1.113883.6.2
85 

 

Cancer Reportability  Primary Site Code 
• ICD-9-CM reportability 

list 
• ICD-10-CM 

reportability list 
 

Primary Site Code 
• ICD-9-CM 

reportability list 
• ICD-10-CM 

reportability list 
 

Date Formatting  Date/Time of Report 
Author Time 
Patient's Address Start Date 
Patient's Address End Date 
Patient's Date of Birth 
Service Event Start Date 
Service Event End Date 
Encompassing Encounter Date 
Encompassing Encounter Start 
Date 
Encompassing Encounter End 
Date 
Occupation Start Date 

Date/Time of Report 
Author Time 
Patient's Address Start Date 
Patient's Address End Date 
Patient's Date of Birth 
Patient Deceased Date 
Encompassing Encounter 
Date 
Service Event Start Date 
Occupation Date 
Occupation Start Date 
Occupation End Date 
Industry Date 

http://phinvads.cdc.gov/vads/ViewValueSet.action?id=EE075D04-3D88-43DE-B45B-CAC36B7F1B62
http://phinvads.cdc.gov/vads/ViewValueSet.action?id=EE075D04-3D88-43DE-B45B-CAC36B7F1B62
http://phinvads.cdc.gov/vads/ViewValueSet.action?id=665B5D36-FC6D-4BD2-B279-3C7C5D89290F
http://phinvads.cdc.gov/vads/ViewValueSet.action?id=665B5D36-FC6D-4BD2-B279-3C7C5D89290F
http://phinvads.cdc.gov/vads/ViewValueSet.action?id=EE075D04-3D88-43DE-B45B-CAC36B7F1B62
http://phinvads.cdc.gov/vads/ViewValueSet.action?id=EE075D04-3D88-43DE-B45B-CAC36B7F1B62
http://phinvads.cdc.gov/vads/ViewValueSet.action?id=665B5D36-FC6D-4BD2-B279-3C7C5D89290F
http://phinvads.cdc.gov/vads/ViewValueSet.action?id=665B5D36-FC6D-4BD2-B279-3C7C5D89290F
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Validation Rule Type Data Elements/Objects 
Checked (MU2) 

Data Elements/Objects 
Checked (MU3) 

Occupation End Date 
Industry Start Date 
Industry End Date 
Smoking Status Start Date 
Smoking Status End Date 
Diagnosis Date 
Active Problem Start Date 
Active Problem Stop Date 
Procedure Start Date (Related 
to Results) 
Procedure End Date (Related to 
Results) 
Result Date 
Procedure Date 
Procedure Start Date 
Procedure End Date 
Medication Start Date 
Medication Stop Date 
Medication Administered Start 
Date 
Medication Administered Stop 
Date 

Industry Start Date 
Industry End Date 
Smoking Status Date 
Procedure Start Date 
Diagnosis Date 
Medication Start Date 
Medication Sop Date 
Medication Administered 
Start Date 
Medication Administered 
Stop Date 
Problem Start Date 
Problem Stop Date 
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